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DREAMWEAVER 3 
 

How to create a site?  
 
From the Site menu, select New Site  (Figure A-1). A Site Definition dialog box (Figure A-2) should appear. 

 
Figure A-1 

In the Site Definition dialog box (Figure A-2), make sure that the option, Local Info, is selected under the 
Category list. Under the Site Name option, give your site a name. For this tutorial, we have chosen the name, 
My_Website. Next, under the Local Root Folder, click on the folder icon next to the text input area. This will 
generate another dialog window called Choose Local Folder (Figure A-3). Inside this dialog box, locate the 
folder you want to work in. Once you found and selected the folder, click Open to return to the Site Definition 
dialog box. Enter http://www.gettysburg.edu for the HTTP Address box and place a checkmark in the Cache: box.  
Click on the OK button to move on to Step 3.  

 
Figure A-2 
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Figure A-3 

The dialog box  shown in Figure A-4 should then appear, prompting you to choose whether you want to create a 
cache file for your site. A cache file keeps a record of existing files in your site so Dreamweaver can quickly 
update links when a file is moved, renamed, or deleted. Select Create . The structure of your site should then 
appear in a dialog box shown in Figure A-5. 

 
Figure A-4 

 

 
Figure A-5  

At that point, move the vertical line in that window all the way to the left edge of the window and resize the window 
so that it is as tall as your monitor screen and as narrow as you can display it so that you can still see the 
filenames.  Then drag the window to the very right hand side of your screen.  You screen should then look like 
Figure A-6. 
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How to Format Text 
 

In Dreamweaver, text can be formatted in many ways. The quickest way to format text is by using the Properties 
palette: 

                
                                                              Figure B-1 

As an alternative, you can perform these functions by choosing any option 
from the Text menu (Figure B-2). The Text menu also carries a few other 
formatting functions that are not found on the Properties palette.  
 

For this tutorial, the focus will be mainly on acquainting you with the 
formatting icons or options from the Properties palette. Please refer to 
Figure B-3 for the number designated to each of these options or icons, 
which will be further described in the table below. 

 
To format text, first select a body of text and then press the desired format 
icon on the Properties palette.  

  
Figure B-2 
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Figure B-3: Refer to the following table for further explanation of each numbered field 

 
DESCRIPTION 

 
1. Text Format 
Text adjusted to a certain format such as a 
heading or a paragraph. There are 6 forms of 
headings, ranging from largest (Heading 1) to 
smallest (Heading 6). 
 
2. Font Type 
The particular font type to be used on selected font 
or text.  
 
3. Font Size 
Designate a particular font size to be used on 
selected font or text. 
 
4. Font Color 
Generate a color dialog box, in which you can 
select a particular color from multiple color option 
boxes to be used on selected font or text. 
 
5. Font Color II 
The hexadecimal representation of the color used 
for selected font or text 
 
6. Boldface 
Boldface selected font or text 
 
7. Italicize 
Italicize selected font or text 
 
8. Left Justify 
Align selected text to the left border of a window or 
a table 
 
9. Center 
Center selected text between the left and right 
margin  

10. Right Justify 
Align selected text to the right border of a 
window or a table 
 
11. Link address 
Transform text into a link. If it is an internal 
link (a web page within the designated 
site), a relative path to the web page can 
be used. Otherwise, the entire URL of that 
linked web page must be stated. 
 
12. File locator 
Locate within the designated site the file or 
web page where the text link will be linked 
to 
 
13. Target Link 
Specifies a particular section of a web 
page where the selected text will link to 
 
14. Unordered List 
Turn selected text into an unordered list 
 
15. Ordered List 
Turn selected text into an ordered list 
 
16. Text Outdent 
Shift selected text closer to the left border 
of a window or a table 
 
17. Text Indent 
Shift selected text further away from the 
left border of a window or a table  
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How to convert text into a link 
Text in HTML can be converted into links. These text links are differentiated from regular text by underlining the 
text and displaying it in blue. In Dreamweaver, converting text into a link can be easily done with the Properties 
palette:  
 

 
point to wheel 

The easiest way to create a link to a web page in the site you’re working in is to highlight the text you wish to 
convert to a link, place your mouse pointer on the “point to file” wheel and hold down your left mouse button while 
dragging your mouse pointer to the file you wish to link to in your file list in the window down the right side of your 
screen as shown below. 

 

The following steps provide another way to perform this simple process. 

First, highlight or select the body of text that you wish to 
convert to a link.  
 
Click on the folder icon next to the Link's text box. This 
will open a Select File dialog box (Figure C-2), in 
which you will locate the file or web page to which the 
text will link to. Press the Select button once you found 
the file. In returning to the original window, you will 
notice that the text is now underlined and colored, 
signaling that it has successfully transformed into a text 
link. On the other hand, if you will be using the text as a 
link to a web page outside your designated site, you 
must enter the entire URL (Uniform Resource Locator) 
or address of the web page to which it will link in the 
Link text box.  Of course, this could be performed by 
copying and pasting the URL from a web page if you 
desire  

                                                        Figure C-2 
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How to insert an image  
You can insert an image onto your web page in several different ways by employing any of the following methods: 

The Objects palette  
The Insert Image option from the menu bar  
The shortcut key of PC or the shortcut key of Mac 
 

The process is the same for all three except for the initiation phase. 

 
                                                              Figure D-2 

 
  Figure D-1 

The initiation phase begins with selecting a method to activate the process. This step 
requires you to choose one of the three methods previously described. If you choose to 
use the Objects palette, click on the Insert Image icon as shown in Figure D-1. If you 
chooses to use the menu bar, select Image from the Insert menu as shown in Figure D-
2. Last, if you choose to use the shortcut key, press [Ctrl] [Alt] + [ I ] simultaneously on 
your PC or [Option] [Mac] + [ I ] on your Mac. Regardless the method you use, it will 
generate the dialog box  shown in Figure D-3. 
 
Select the file you want to insert. Once found, press the Select button and the image should 
then appear at the cursor position where the process was activated. 

 

 
Figure D-3 
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How to create a link from an image 
You can use an image to link your web page to a secondary web page. The process requires the use of the 
Properties palette shown in Figure E-1. 

 
Figure E-1 

If the Properties palette is not opened, you can activate it by selecting the option Properties from the Windows 
menu (Figure E-2).  Alternatively, you can press [Ctrl] and [F2] to activate it.  

  

 
Figure E-2 

  
Start by highlighting the image you wish to use as a link. If you have successfully highlighted the image, there 
should be a black border around the image (Figure E-3). Notice also that the look of the Properties palette  has 
also changed (Figure E-4). It now shows the properties of the image. 

 

 
Figure E-3 : Result of highlighting an image 

 

 
Figure E-4: Appearance change of the Properties palette as a result of highlighting an image 
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To create the link once the image is selected, follow any of the same instructions as in the previous section for 
creating a link from text; the process at this point is the same. 
 
NOTE: In some instances, a border might surround an image after a link has been created. The border indicates 
that the image has been formatted to be used as a link. If you wish to delete this border, highlight the image and 
type in 0 for the border specification in the Properties palette . Be very cautious if you are using a borderless 
image as a link. Make sure web users are aware that the image is a link by specifically writing a message 
alongside the image.  
 

How to create an image map 
What is an image map? An image map is simply an image in which regions or hotspots have been created to be 
used as a link to different web pages or to a partcular section on a web page.  

To see the usefulness of an image map, let's imagine that you are the professor of a history class about North 
America. You have created a course web page for your students who can readily turn to your page to access 
information about the different countries located in the North American region. The most basic way to do this is by 
including text links on the web course page as opposed to image links. However, this type of links lacks appeal 
and interest. To visually stimulate your student, you might want to retrieve a map of North America and then carve 
out regions on the map where appropriate links can be set up to retrieve information about these regions . An 
example of this image map is shown on Figure M-1. 

 

Figure M-1: An example of the usage of image map. The user would click on a country to go to a link for that region.  

How to Create such an Image Map 

First, highlight the image that will be used for the image map. Once highlighted, you should notice a change in the 
orientation of the Properties palette as shown in Figure M-2. 

  
Figure M-2  
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Determine the shape of the area(s) that will be carved out from the image. This is important because an image 
map can be only one of three types. The three types are rectangle, oval and polygon. Once you have determined 
the shape, select the appropriate HotSpot icon from the Properties Toolbar. Return to the image and carve 
out the section for this particular image map. Once you have done that, you should notice that the mapped-out 
section should be highlighted (Figure M-3).  

 

Figure M-3: The three highlighted or image mapped regions of the original image  

Once all hotspots have been carved out from the original image, select one of the hotspots. Notice once again the 
change in the orientation of the Properties palette (Figure M-4). Now, enter a name for this particular hotspot 
under the category, Map. Next, use the “point to file” to drag your mouse pointer to the file you wish to link to or 
search the location of the file to be linked to for this particular hotspot by clicking on the folder icon immediately 
following the text field for the category, Link. If the location is not within the local site, you must specify the entire 
URL. If the mapped area is used as a link to a particular section of a local web page, you may search for the 
name of that section under the list menu in the category, Target. However, if the targeted section is not listed, you 
must specify it, beginning with a "#" followed by the name of that section. Finally, you may wish to give this 
hotshot a label in the Alt category. The label will be shown once the cursor is positioned over the hotspot. Repeat 
this procedure for the remaining hotspots you have created.  

 
Figure M-4 

 

How to insert a rollover image 
As stated in our previous Dreamweaver tutorials, you can create dynamic web pages with some of the unique 
features that are already built-in. One of the most commonly used features is a rollover. Rollovers are very 
commonplaces on the WWW today and it is essentially an image that is used to replace an original image when a 
cursor falls over the original image. Often time, these rollovers are used in conjunction with a link. Since using a 
standalone image as a link can be quite static and web users might not readily know that it's a link, a rollover 
could easily convey this idea to the web user. Moreover, a rollover is more appealing to the eye. In this tutorial, 
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we will demonstrate how to create a rollover, one that is similar to Figure J-1. Like any other rollovers, the one 
featured in Figure J-1 utilizes two images. The first image is the blue Dreamweaver image and the second is the 
yellow Dreamweaver image, which will replace the blue Dreamweaver image once a cursor is positioned over it. 
As a rule in creating a rollover image, the two images must be of the same size. If you try to bend this rule, the 
rollovered image will be adjusted to the size of the original image. 

 
1. From the Objects palette, select the Insert Rollover Image option (Figure J-2). This 

will open up a dialog box called "Insert Rollover Image" (Figure J-3). 
 

2. In this dialog box, type in a name for this rollover image in the provided text area 
under the category, Image Name . Next, click on the "Browse..." button next to 
the text area for the category, Original Image . A secondary dialog box will open, in 
which you will locate the image file that you want to use as the original image. Repeat 
this procedure for the Rollover Image category. Afterwards, check the square box for 
the option, Preload Rollover Image. By checking this option, the rollover image will be 
loaded during the initial startup of this web page instead of at the moment when the 
cursor has fallen over the original image. Thus, the rollover effect will become 
apparent to the web user at once. Finally, click on the "Browse..." button for the 
category, "When Clicked, Go To URL". This will open up yet another dialog box. 
Locate the web page that you want this rollover image to link to. If the web page is 
located outside your local site, you must specify the entire address of the web page. 
Press the OK button once every category has been filled out. Now preview the page 
and you should notice the rollover effect. 

 

Figure J-2 

Figure J-3 

 

 
How to create a list 
Before you create a list, decide which particular type of list is best to convey your ideas. There are three types of 
list. The first type is an ordered list. Items listed in an ordered list are numbered, starting from 1. The second type 
is an unordered list. As the name suggests, items listed are not sorted or ordered. Instead, each item is bulleted. 
The third type is a definition list. As the name implies, this particular type of list is best suited for defining a term. 
The difference between these lists is contrasted in Figure F-1. 

 
Unordered List Ordered List Definition List 

• Dogs 
• Cats 
• Mice 

1. Dogs 
2. Cats 
3. Mice 

Dog 
An animal which is often 
claimed as a man's best 
friend. 

 Figure F-1  
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In the case of creating an unordered list or an ordered list, you can use either the Properties palette  or the Text 
menu. The Definition list, however, must be created from the Text menu. The following steps demonstrate how to 
create each type of these lists. 

 

How to create an unordered list, an ordered list, or a definition list 
Highlight the items (Figure F-2) that will be used in the list. Make sure each 
item is separated by a paragraph. 
 
The second step varies depending which method you choose to use to create 
the list. If you wish to create this list by using the Properties palette , just click 
on the Ordered List button (Figure F-3) or the Unordered List button 
(Figure F-4). On the other hand, if you wish to create the list by means of the 
menu bar, just choose the appropriate type of list appearing in the List 
option under the Text menu (Figure F-5). Please note that the Definition list 
can be created by choosing the option, Definition List, from the Text => List 
menu.  
 

 
Figure F-2 

 
Figure F-3 : Ordered List button on the Properties Toolbar 

 
Figure F-4 : Unordered List button on the Properties Toolbar  

 
Figure F-5 : Creating a list from the the text menu 
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NOTE:  Instead of inputting the items of a list onto the web page first, you can also build a list as you type. Just 
press the list button of your choice on the Properties palette  or choose your list selection from the Text 
menu first before you start inputting the items of the list. Then enter the first item of your list. Each time 
you press [Enter] from here on out, it will automatically move to the next item on the list. Now that you 
have a basic understanding of a list, you can move on and learn how to create a more sophisticated type 
of list called nested list in this following tutorial. 

 
How to build a nested list 
In some situations, a regular ordered list or unordered list might not be ideal to define items under the proper 
classification or structure. You might need to have items listed inside or under an item in another list. A perfect 
way to solve this problem is to build a nested list, or a list within a list. An example of a nested list is shown below. 

• ANIMALS 
o Birds 

1. Parrot 
2. Pigeon 

o Mammals 
1. Whale 
2. Human 

• PLANTS 
     (Figure G-1) 

To create a nested list, you will be utilizing some skills you have learned in the previous section on how to create 
a list. In addition, you will learn how to use the Text Indent and Text Outdent buttons on the Properties palette 
(Figure G-2) to turn your regular list into a nested list.  

 

 
Figure G-2 

 
Utilizing Figure G-1 as our guide, type in all items found on that list. Remember to separate each item of a list with 
a paragraph. Following this step, your temporary list should appear as follows: 

 
ANIMALS 
Birds 
Parrot 
Pigeon 
Mammals 
Whale 
Human 
PLANTS 

 
Now highlight, or select all items of the list and press the unordered list button on the Properties palette. This 
will generate an unordered list similar to the one shown below: 

• ANIMALS  
• Birds 
• Parrot 
• Pigeon  
• Mammals 
• Whale 
• Human 
• PLANTS 
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Place your cursor in front of Birds. Now press the Text Indent button on the Properties palette. In addition 
to the text shift, you should also notice that the bullet has changed from a closed bullet to an opened 
bullet for the purpose of differentiating the two lists or groups. Repeat this procedure for Mammals. 
Following this step, your list should now look similar to the one below: 

• ANIMALS  
o Birds  

• Parrot 
• Pigeon  

o Mammals 
• Whale 
• Human 
• PLANTS 

Place your cursor in front of Parrot. To make Parrot a subgroup of Birds, press the Text Indent button twice. 
You should notice that the closed circle bullet has turned into a closed square. You can then turn this unordered 
list item into an ordered list item by pressing the Ordered List button on the Properties palette. Repeat this 
procedure for Pigeon, Whale, and Human. Afterwards, your list should have successfully turned into a nested list 
like the one at the top of page 10. 

 
How to build a table  
A table is a simple way to organize data on a web page. Tables are two dimensional, comprising of rows and 
columns. The intersection between a row and a column is known as a cell. A table and its cell(s) have several 
properties, which can be changed to render the setting you desire. In Dreamweaver, the properties of a table can 
be changed inside the Properties palette (Figure H-1). Likewise, a cell's properties can also be changed inside the 
Properties palette (Figure H-2). As you can see from the figures, the orientation of each palette is different from 
another. 

 

 
Figure H-1 

 

 
Figure H-2 

The following chart provides a brief summary of each table or cell property found on the Properties palette. 
 

PROPERTY DESCRIPTION 

Table Name A name given to a table 

Rows The number of rows in a table 

Cols The number of columns in a table 

W 
(Width)  

The size of a table or a cell, which can be specified in terms of 
percentage or pixels.  



Dreamweaver 3 Tutorial 10/2000 Page 14 

H 
(Height) 

The size of a table or a cell, which can be specified in terms of 
percentage or pixels 

CellPad 
The number of pixels betwen the border and the actual contents of a 
cell in every cell of a table  

CellSpace The number of pixels between every cell in a table 

Align 
The particular alignment of a table. Options include left-justified, 
center, or right-justified 

Border The size of a table's border specified in pixels 

VSpace 
The amount of vertical space or the number of pixels separating a 
table vertically from contents outside the table 

HSpace 
The amount of horizontal space or the number of pixels separating a 
table horizontally from contents outside the table 

Light Brdr The color specified for a table's thin border 

Dark Brdr The color specified for a table's thick border 

Bg (1) The file which will be used to create the table's background  

Bg (2) The color specified for a table's background.  

Brdr The color specified for a table's border 

Horz Specifies the horizontal alignment of contents inside a cell 

Vert Specifies the vertical alignment of contents inside a cell 

No Wrap 
Specifies whether content that are larger than the allotted cell size will 
or will not run over to the next line. If checked, the cell would expand 
hori.  

Header 
Specifies whether the content of a cell will be used as a heading. If so, 
the cell content will be boldfaced and centered 

Before building a table, it is wise to think about the number of rows and columns that will be needed to host your 
available data. Once you have determined a suitable number, you can then go ahead and use the following 
guidelines to build one. 

There are three ways to initiate the process. The first method utilizes the Objects Palette, which contains a create 
table button (Figure H-3). The second way to initiate the process is by selecting Table from the Insert menu. For 
the third option, you can use the hot keys for your appropriate platform. On a PC, press [Ctrl] [Alt] + [T] 
simultaneously. On a Mac, they are [Option], [Mac key], + [T]. Regardless which method you choose, the action 
performed will open a dialog box called Insert Table (Figure H-4). 

 
Figure H-3: Insert Table icon on the Objects Palette 
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Figure H-4: Insert Table dialog box 

In this Insert Table dialog box, enter the specification for each category as you desire. For a review of the 
meaning of each of these categories, you can return to the table located above. Once you finished entering all the 
specification, click on the OK button. This will generate a table at the cursor point where you initiated the process.  

 
What are layers? 
A layer can be described as a container for HTML content. Similar to regular HTML web pages, layers can 
contain text, images, forms, plug-in objects, and even other layers. In other words, any element you can place in 
the body of an HTML document, you can also place in a layer. The one major distinction between layers and 
regular HTML documents is that layers give web page designers greater control over the exact pixel placement of 
elements. Also with layers, web designers can control which objects will appear in front of another object and 
which objects will be displaced or hidden. Furthermore, web designers have the option to use a timeline to move 
a layer or several layers simultaneously across a screen. 

 
In Dreamweaver, two types of layer formats can be used to position content on a page. These formats are CSS 
layers and Netscape layers. CSS layers are defined by the World Wide Web Consortium's Positioning HTML 
Elements with Cascading Style Sheets. Netscape layers are defined by Netscape's proprietary layer format and 
therefore, are only supported under Netscape Navigator. Before proceding to use layers for your web site, you 
should be aware of the fact that earlier versions of both browsers will display the contents of a layer but will not 
position them. In the following section, we will show you how to create layers and set up their properties. 
 

How to create dynamic web effects with the Behaviors Palette 
You can easily create dynamic web pages by incorporating some of the unique features that are built into 
Dreamweaver. To utilize these features, you must learn how to use the Behaviors palette (Figure I-1). A key 
restriction of these features is that they can only be applied to certain objects such as an image or a form. In this 
tutorial, we will demonstrate some of the types of effects you can build using Behaviors.   

 
Figure I-1 
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How to create dynamic web effects with the 
Behaviors palette 

 
To activate the Behaviors palette, select the option, Behaviors, from the 
Windows menu. Alternatively, you could press [F8] on the keyboard. 
 
Highlight the object that you want the effect to be performed on. Then 
click on the "+" sign on the Behaviors palette. This will generate a menu 
list of effects (Figure I-2). Select the effect that you want. Regardless of 
the effect you selected, an ensuing dialog box will open, in which you will 
need to fill out all the required elements. The following table summarizes 
and demonstrates some of the more common effects or actions. 

 
 

Figure I-2 
 
 

  

Call JavaScript 
This action places a call to a javascript program. This requires some 
user knowledge of Javascript programming and it is beyond the scope 
of this tutorial.  

Change Property 
This action allows certain properties of a selected object inside a web 
page to change depending on which browser the web user is using. 

Check Browser 
This action checks the brower that the web user is using and based on 
the result, it can redirect the web user to different web pages. 

Check Plugin 
This action checks whether a particular plugin has been installed 
inside the web user's computer. If not, it can automatically redirect the 
user to a source location where they can download the plugin.  

Go to URL 
This action automatically links the current web page to another web 
page once the object is selected.  

Open Browser Window  
This action is similar to the "Go to URL" action except a new window is 
used to display the linked web page. The user can also specify the 
properties of this window.  

Play Sound 
This action opens or downloads a sound file once the object is 
selected.  

Popup Message  
This action opens a dialog box with the predefined message once the 
object is selected 

Swap Image  
This action displays a rollover image once a cursor is over the original 
image. 
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How to create a template 
The purpose of creating a template is to assist you with creating a web site that has a consistent design across all 
web pages. A template is quite often referred to as the the foundation of other documents. If you are using a 
certain constant format to create your web pages, but at the same time, you make only minimal revisions or 
updates to them, it would be a time-consuming ordeal to go through every web page and make these changes. 
Using a template can solve this problem. Any changes made to a template will automatically induce 
Dreamweaver to locate all web pages that were made with this template and to update these revisions.  
 
To see how a template can be an extremely beneficial tool, let's imagine that you are the professor of a course 
called Earth 101. You have decided to post all course-related materials on the web. The format of each web page 
will be the same with the course title on top, links beneath the title, a main content area to the right of the links, 
and your email link at the bottom (Figure K-1). Judging from this prescribed format, the only area that will change 
constantly is the main content area. Therefore, you can save yourself time and trouble by making a template with 
these four sections and designating the main content section as the only editable section. By doing so, every new 
page that you create from this template will carry this same format and thus, you can shift your focus entirely on 
creating the content for the main section (Figure K-2). What's even more appealing with creating web pages from 
this template is that in the event that you need to amend your template such as adding additional links, all 
changes you make will be updated to those template-based web pages. 

 
Figure K-1: Template with editable section highlighted 

 

 

Figure K-2 : Examples of web pages dervied from template 
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1.  Select Templates from the Windows Menu. Alternatively, you can press [Ctrl] + 
[F11] on a PC. This will open the up a Templates palette (Figure K-3).  

2.  Press the New Template button on the Template Palette (Figure K-3). A blank 
template will be created. While the template is still highlighted, you can enter a 
new name for this template. 

3.  To edit or create the content for this new template, double click on the template 
name inside the Templates Palette. This will open up the template file.  

4.  For this particular step, we recommend that you design the entire layout and input 
all necessary content onto the template before moving forward with the following 
instructions. Once you have finished designing and inputting all the content, you 
must now decide which sections of your design should be editable. Let's make 
believe that you have come up with the design as shown in Figure K-1. From the 
design, you could easily tell that the only sections that will be changed constantly 
are the two highlighted setions titled, "Title of this section" and "This is the main 
content of the web page". For each of these sections, highlight it and then 
select Templates => Mark Selection as Editable from the Modify menu 
(Figure K-4). Alternatively, you can highlight it and then press [Ctrl], [Alt] + [W] 
on a PC. This will open a new dialog box called New Editable Region (Figure K-
5), where you have to specify a name for each of these editable regions. Once 
you finished specifying all the editable regions, save the template. 

 

 
          Figure K-3 

 

Figure K-4 

 
Figure K-5 
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How to create new web pages from a template 
 
From the Files menu, select New from Template and choose your desired template to create this new 
web page. This will open up a new web page, in which you will be allowed to make changes only to those 
areas that are not highlighted. 
 
You can go directly to an editable section by selecting the name of that section under the Templates option in the 
Modify menu. (Figure K-6). 

 

 
Figure K-6 

Once you have edited all contents in the editable regions, save the file.  

 
What is a form? 
 

A form is typically used for obtaining data from a web user. Data are obtained for many purposes, some of which 
includes on-line purchasing, feedback, and quizzes.  

In this tutorial, you will learn how to create a simple form and use a UBWingsmail program to send the form data 
to a number of e-mail addresses here at UB. The program is readily available to you so you don't need to write 
the program yourself. However, for other form projects in the future, you may need to acquire some programming 
skills to handle your project specific needs. The skills required in programming with forms are beyond the scope 
of this tutorial. However, you can find many web sites on the WWW, which provides extremely useful programs 
that deal exclusively with data processing in forms. 
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How to build a form 

On the Objects Palette, click on the down arrow located next to the word, Common (Figure L-2). This will open a 
menu list of options, of which you will select Forms. After this selection, you should notice that the objects inside the 
Objects palette has changed to forms' objects (Figure L-3). 

 
Figure L-2 

 
Figure L-3 

Next, Insert a form onto your web page. Click on the "Insert Form" icon, , on the Object toolbar. This will open 
up a dialog box (Figure L-4) in which you will give your form a name. Next, locate the program that will be used to 
process the data by clicking on the folder icon next the Action's textfield. If the program in located outside your 
local site, you must specify the entire URL (for example):  

http://www.wings.buffalo.edu/cgi-bin/wingsmail 

For the category, Method, select the POST option. The difference between Get and POST is that Get appends 
form values to the URL and sends the server a GET request while POST sends form values in the body of a 
message and sends the server a POST request. 

 
 

Figure L-4 

This step will utilize some of the form elements on the Forms palette. Regardless of which form element you 
select, it must be inserted inside that form that you have previously created. This means that each form element 
must be placed inside the red-dotted line area. In addition, each form element must have a different name. Each 
name will serve as a label to the each piece of information submitted by the user. The following table provides a 
brief description of each form element. 
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ICON ELEMENT NAME DESCRIPTION 

 INSERT FORM  
The starting point of building a form. Must be placed on the page 
first. A red dashed box should be created after this action. All 
other forms must then be inserted within this box.  

 INSERT TEXT FIELD 

An area in which text can be written into. Several dimensions of a 
textfield can be changed. They include the width, the number of 
lines it spans, the maximum number of characters allowed in the 
area, and the input text characteristic (regular or cyrptic, password 
form). It can also be initated with a default value. 

FIRST NAME:  

PASSWORD: ********  

 INSERT BUTTON 

A button used to activate some course of action such as submit-
ting form data or resetting form data.   

Submit
 

 INSERT CHECK BOX 

A selection or check box. Numerous check boxes can be checked 
to a given question or statement and all values associated with 
these checked boxes will be sent to the program 

Which of the following classes are you currently taking? 

gfedc Math gfedc Art  

 INSERT RADIO BUTTON 

A radio button. Unlike a check box, a group of radio buttons is 
commonly used to restrict users from selecting more than one.  

What is your sex? 

nmlkj Male 

nmlkj Female 

 INSERT LIST/MENU 

An option list displaying the options a user can choose from. Only 
one selection can be made to a given question or statement.  

Math
 

 INSERT IMAGE FIELD 
Inserts an image field at the current cursor location. It is used as a 
substitute for the Submit button.  

 INSERT HIDDEN FIELD 
Inserts a hidden field. The value associated with this field is sent 
along with other values during submission.  

 INSERT JUMP MENU 

Insert a jump menu. This jump menu contains a list of URLs which 
automatically open upon the user's selection. 

Walkway
 

Create the following form elements with the listed specification:  
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FORM ELEMENT  SPECIFICATION 

HIDDEN FIELD 

name = to 
value = e-mail_address(es)  
 
* If multiple e-mail addresses are given, each value must be 
separated with a comma 

HIDDEN FIELD  
name = subject 
value = subject_of_the_message 

HIDDEN FIELD 
name = source 
value = name_of_your_form_page 

HIDDEN FIELD 
name = source-url 
value = full_URL_of_your_form_page   

HIDDEN FIELD 

name = return 
value = full_URL_of_sent_web_page 

* The value specifies the page to which the user will be sent after 
he submits the data 

TEXTFIELD 
name = 01. Name 
type = Single line 

TEXTFIELD 
name = email 
type = Single line  

TEXTFIELD 
name = 02. Comment 
type = Multi line 

BUTTON 
value = Send Message 
Action = Submit form 

Following this step, your form should look as follows.  Note: please be aware that the label in front of each 
textfield was created manually. 

 

Save the webpage and test the form by submitting a message to yourself. 
 

How to Create Layers 

From the Objects toolbar, select the Draw Layer icon, .  Position your cursor anywhere on the web page. Now, 
left click on your mouse and drag the cursor until the layer's size meets your specification.  
 
Before proceeding to insert HTML elements into the layer, you may wish to change some of the specifications of 
the layer. To administer the changes, you must select the entire layer by clicking on the tab of the layer (Figure  
N-1). Notice the orientation of the Properties palette has now changed to include the attributes of this particular 
layer (Figure N-2).  
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Figure N-1  

 
Figure N-2 

 The following table describes the attributes that are associated with each layer.  

ATTRIBUTE DESCRIPTION 

 
Layer ID:  A name given to a layer. Primarily used to identify the layer for scripting. 
 
L, T:  The position of the uppermost left corner of the layer with respect to the top left corner of the web page or 
the parent layer. Expressed in pixels 
 
W, H:  The width and height of the layer in pixels. 
 
Z-Index:  An index given to a layer to express its relative position with respect to other layers when they are 
stacking against each other. A higher number indicates that a layer will be shown above layers of a lower number. 
 
Vis : The visibility of the layer. One of four options can be chosen: Default, Inherit, Visible, and Hidden. The 
"Default" option does not specify a visibility property. Most browsers would simply inherit the property of the 
parent. Choosing the option, "Inherit", specifies that the visibility of this layer should be derived from its parent. 
The "Visible" option displays the content of the layer regardless of the parent's property. Finally, the "Hidden" 
option hides the layer's content regardless of the parent's property. 
 
Bg Image : A file chosen to be the background of the layer. Click on the folder next to the textfield to locate the 
file to be used.  
 
Bg Color: Using a selected color from the color palette or a color of your own choosing to be the background 
color. 
 
Tag: Specifies which layer format you wish to employ to create your layer. The selection can be based on the 
CSS format which encompasses the options, DIV and SPAN, or the Netscape format which encompasses the 
selections, LAYER, and ILAYER. 
 
Overflow: This option is only applicable if you are using the CSS layers format. Overflow determines what 
happens if the contents of a layer exceed its specified size. Four options are available: Visible, Hidden, Scroll, and 
Auto. The "Visible" option increases the layer size so that all of the layer's contents are visible. More specifically, 
the layer expands downward and to the right. The "Hidden" option maintains the layer's size and cuts off any 
content that doesn't fit. The "Scroll" option adds scroll bars to the layer regardless of the size of the contents 
inside the layer. The "Auto" option provides scroll bars automatically when the layer's contents exceed its 
boundaries. 
 
Clip: Specifies the visible portion of the layer. Enter the pixel location for the four fields: T, L, R, B.The T field 
specifies the topmost pixel location of the visible area with respect ot the top boundary of the layer. The L field 
specifies the leftmost pixel of the visible area with respect to the left boundary of the layer. The R field specifies 
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the rightmost pixel of the visible area with respect to the right boundary of the layer. Finally, the B field specifies 
the bottom-most pixel of the visible area with respect to the the bottom boundary of the layer. 
 
Left, Top, Page X, Page Y: These fields only appear if you have chosen either LAYER or ILAYER under the Tag 
field. The Left and Top options specify the the location of the layer with respect to the top left corner of the parent 
layer. Page X and Page Y specifies the location of the layer with respect to the top left corner of the web page, 
overriding the specifications for Left and Top. 
 
Src: This field only appears if you have chosen either LAYER or ILAYER under the Tag field. The "Src" field 
allows you to choose an HTML document to be displayed inside the layer. Click on the folder icon next to the 
textarea to locate and select the HTML document. 
 
A/B: This field only appears if you have chosen either LAYER or ILAYER under the Tag field. This field lets you 
specify which layer will be placed Above or Below the current layer. 


